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What you should know
about your camera:

mWhere is your instruction manual
= What kind of memory card it uses
= How many megapixels

mWhat type of battery it uses

0 Canon FUJIFILM sworesr201 [

g DIGITAL CAMERA Before You Begin L
2 EOS']. D] FINEPIX XP50 Series " o]
ﬁ Mark il Owner’s Manual waicawogutyna i ||
a o h SECD KT ' Maseca Photogapty
| i

wiw = (0 2 B HOmMIY




2/14/14

What you should know
about your camera:

- Where is your instruction manual
- What kind of memory card it uses
- How many megapixels

- What type of battery it uses
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What you should know
about your camera:

- Where is your instruction manual

- What kind of memory card it uses
- How many megapixels

- What type of battery it uses
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Murphy's Memory Card Capacity Chart

Camera 10GB | 20GB | 40GB | 80GB | 16GB 32GB
6 Megapixel JPEG 300 600 1200 2400 4800 9600
8 Megapixel JPEG 270 540 1080 2160 4320 8640
9 Megapixel JPEG 255 510 1020 2040 4080 8160
10 Megapixel JPEG 225 450 900 1800 3600 7200
12 Megapixel JPEG 200 400 800 1600 3200 6400
15 Megapizel JPEG 150 300 600 1200 2400 4800
22 Megapixel JPEG 135 270 540 1080 2160 4320

Approximate Number of Images Per Card*

approximately double the capacity of the card.

* Exact Number of images will vary from camera to camera. Estimates based on "High-Resolution" camera
settings with the least amount of JPEG compression. By shooting at the "Normal" or "Low" resolution you can

What you should know

about your camera:

How many megapixels

What type of battery it uses
- 000000000000

Where is your instruction manual

What kind of memory card it uses
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Camera
Settings
S

Know how to set:

- ISO = light sensitivity
setting

- F-stop/Aperture

- Shutterspeed

- Image quality setting
- Image Size

- White Balance

- Colorspace
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ISO =
light sensitivity




F-stop/Aperture

fa f15.6 T8

I /2.8
fi2

meaning less viewing area in focus from front to back

fi1.4
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Shutterspeed



1/500 of a second
to stop action
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1/30 of a second
to blur action
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Image quality
setting

Quality ..o imse

Approximate Values for Recording Pixels

Recording Pixels

Purpose”

High [Printing to about A3-size
(Large) g | 3264 X 2448|1997 x 420 mm (11.7 x 16.5
pix in.)
Printing to about A4-size
. 2592 x 1944 210 x 297 mm (8.3 x 11.7 in.)
(Medium 1) | 5M pixels Printing to about Letter-size
216 x 279 mm (8.5 x 11in.)
. 2048 x 1536 Printing to about A5-size
m (Medium 2) | 3M pixels 148 x 210 mm (6 x 8.3 in.)
1600 x 1200 l;’zigt p10 &t)card-?isz b gr_int)s
. X X mm (6 x 4 in.
m (Medium 3) | 2M pixels Print L-size prints
1M9x89mm (4.7x3.51In.)
640 x 480 v Send images as e-mail
H (small) 0.3M pixels Low |attachments or shoot more

images

14



Compression

Approximate Values for Compression Settings

Compression Purpose
E Superfine | High Quality | Shoot higher quality images
u Fine i Shoot normal quality images
] Normal Normal |Shoot more images

Lossy Compression

(Destructive)

Image Data Sizes (Estimated)

Recording Pixels E Com;gssion n
3264 x 2448 pixels 3436 KB 2060 KB 980 KB
[ 2592 x 1944 pixels 2503 KB 1395 KB 695 KB
m 2048 x 1536 pixels 1602 KB 893 KB 445 KB
[H 1600 x 1200 pixels 1002 KB 558 KB 278 KB
H 640 x 480 pixels 249 KB 150 KB 84 KB
[s2 1600 x 1200 pixels — 558 KB —
EI 3264 x 1832 pixels 2601 KB 1540 KB 736 KB

2/14/14
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mEconomy -
meNormal :

mFine '
‘-Fine

[ET Setting the Image-Recording Quality =

Set the recording quality to suit the intended Image size for printing, etc
Note that the recording quality will also affect the number of shots the
CF card can record. Select the recording quality while thinking about
the capacity of the CF card to be used. Also see "Guide to Image-
recording Qualty Settings” below and *FAQ" on the next page.

Select the image-recording
quality.

@ Under the [€31] tab, select [Quality)
and press <&3>. Set it to the desired
recording quality such as (ML), then
press <>

[Quality] will be displayed

The figures (**** x ****) displayed on
the upper nght Is the actual pixel
count (horzontal x vertical) for the
respective quality setting

oV

Guide to Imag @ Quality o
Quality Pixels ":;‘:“ Paper size
A3 (42x29 Tam/16.5x11.7in,
aL High | Approx 101 | 128 § IL)
aL quality million 248
am Medim | Approx.53 | 215
aMm quality million 409
as Low | Approx.25 374
I i
a5 quaity mien 708 17.8x12. Temy/7 0xS Oin.
sy High | Approx 101 | 48 14.8x10cm/5.8x3 Sin.
Em- AL | suality million 26

* Apphes to a 512MB CF card
* Except for the @) mode, the JPEG 1s usad to record the image in al the
recording-quaity modes.

2/14/14
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White Balance

mAuto
mDaylight
mCloudy
mShade
mFlourescent
mTungsten

-Tunﬂsten

2/14/14
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ProPhoto RGB
~
o~
Adobe RGB
>
sRGB

2200 Matt Paper

Horseshoe Shape of Visible Color

[[IE1 Setting the Color Space* m——

The color space refers to the range of reproducible colors. With this
camera, you can set the color space for captured images to sSRGB or
Adobe RGB. For normal images, sRGB is recommended. In the Basic
Zone modes, sRGB is set automatically.

1 Select [Color space].
@ Under the [£32] tab, select [Color
space), then press <@>.

oz T 2 Set the desired color space.
:EB ® Select [SRGB] or [Adobe RGB], then
lash exp comp ~
W8 SHIFT/BKT press <f1>.

Custom W8

Color space »SRGB
Picture Style |Adobe RGB
Dust Delete Dat¢

About Adobe RGB
This is mainly used for commercial printing and other industrial uses.
This setting is not recommended if you do not know about image
processing, Adobe RGB, and Design rule for Camera File System 2.0
(Exif 2.21).

Since the image will look very subdued with an SRGB personal
computer environment and printers not compatible with Design rule for
Camera File System 2.0 (Exif 2.21), post-processing of the image with
software will be required.

2/14/14
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The More Pixels
the better

Image Size: Large (best quality)
Compression:Least=highest Quality
ColorSpace: Adobe RGB 1998

Good Composition

A pleasing arrangement of
objects, mass, lines and
contrasts of colors to form a
harmonious whole

2/14/14
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What makes a good
photograph?

You Be the Judge

2/14/14
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3 Essentials of a
good photograph

- Good Technical Quality
- Interest or Impact
- Good Composition

Good Technical Quality

- No camera movement
-Correct body position
- Correct focus
-Person’s eyes
-Selective/depth of field
- Lighting
-Front, back, side
- Exposure

2/14/14
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Interest or Impact

- Tell a story
- Express a mood
- Make a pattern

Good Composition

mGet loser

2/14/14
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SCUFI

Shoot
Close

For
Impact

Good Composition

mGet loser
mR lectTh °
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mGet closer
mRule of Thirds
mVantage point



Good Composition

mGet loser

=R lecrTh '

mVan. T
mFraming movement

Keys to Success

- Keep it simple

- Try vertical & horizontal

- Place subject off-center

- Try unusual points of view

2/14/14
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IPhotography

Capturing, storing, processing,
and distributing photos on
iDevices

Different sensor sizes from Full Frame to
1/3.2-inch compared with each other

BFull Frame
B APS-H
APS-C
APS-C ey
1.5"
MFT 4/3”
e
W12
23
W17
123
W32

2/14/14
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The sensor sizes usually used in smartphones are
1/3.2-inch or 1/3-inch, though the Nokia 808 used a
1/1.2-inch one

BFull Frame Il1/1.2” I1/3" Il1/3.2

What different-sized sensors — Full Frame, APS-C, MFT, 1-inch, 2/3-inch, 1/2.3-
inch, 1/3.2-inch — would have captured if using the same lens to take this photo

B Full Frame JJll APS-C MFT 4/3" i B RIEEY  RIEEY

http://www.gizmag.com/camera-sensor-size-quide/26684/

2/14/14
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http://www.gizmag.com/camera-sensor-size-guide/26684

Understanding Pixels

Typical Rmmoni Print Size & Quality
Sensor  (WxH) Exeellem@SOOdpii Good @ 200dpi  Poor @ 150dpi

2464 x 1632

3008 x 2000

3264 x 2448
| 3872x2592
| 4290 x 2800 15" x 10"
16 MP | 4920 x 3264 17" x 11"

35mm Film
(Scanned)

36MP | 7360x4912 | 24" x 16" | 36" x 24"

| 5380x 3620 | 18" x 12"

WWW.DIGITALPHOTOGRAPHYLIVE.COM

Front Camera Trouble
Model Front Camera Rear Camera
iPhone 5s/5¢ 1280 x 960 3264 x 2448 8mp
iPhone 4s 640 x 480 3264 x 2448 8mp
iPhone 4 640 x 480 2592 x 1944 5mp
iPad 4 1280 x 960 2592 x 1944 5mp
iPad 3 640 x 480 2592 x 1944 5mp
iPad mini 1280 x 960 2592 x 1944 5mp
iPad mini 2 1280 x 960 2592 x 1944 5mp
iPad 2 640 x 480 1280x720 1mp

2/14/14
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¢ v @

Dropbox Web Albums Shutterfly

e )@

Flickr Facebook Twitter Instagram Pinterest

SocialNumbers

Facebook | Twitter | Instagram Flickr Dropbox

Max Photo 2048 x 1024x | 2048 x 2048px

o 2048px 2048px 200 MB 150 MB
MaxPhotos | 1900Pe | 460 shown |  unlimited 1 Terabyte 2GB

album
Maxprint | 4x6-8x10 | 4x6-8x10 6x6 unlimited unlimited

Need
account to YES NO YES NO YES

view?

2/14/14
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How To Grab Still Images
From Video

Presented
by

David Keto

Media Producer/Director
University of Wyoming
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How to grab still images from video
Freeze Frame Rules of Thumb

* Pick a frame with limited to no motion

Freeze Frame Rules of Thumb

* Freeze frame is usually 72 DPI, so use it for
web and smaller photos in print

nnnnnnnnnnnn

‘I CAN'T EVEN DESCRIBE ACCURATELY AND ADEQUATELY
HOW MUCH 4-H INFLUENCED ME IN MY LIFE'

not for Head, Heart, Hands,  and then | advanced through
Hy

el by d gets for the US.

ing [
been what shaped my Meand  Forest Service and the USDA.
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Howto Create a Freeze Frame
 Depends on software available

» JPEG is the most common output

How to Create a Freeze Frame

* In any program position the “plavhead” on the
frame you would like to grab a still from, be sure
the video is paused

* Usually you can use the arrows to toggle back
and forth to find the exact frame you would like
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Howto Create a Freeze Frame
* Windows Media Player
—Control+!
» Windows Movie Maker
—Tools
— Take picture from preview
* iMovie (not easy in latest versions)

—Put single frame you want to freeze in a new
sequence

— Export toquicktime
—Movie to image sequence

How to Create a Freeze Frame
* Final Cut Pro 7

— Export>using quicktime conversion

— Format>stillimage

* Final Cut X

— File>Share>Save CurrentFrame

— *requires enabling "save current frame" in the
"destination" options first

35
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How to Create a Freeze Frame
» Adobe Premier

— Click "export frame" button

— *requires enabling "export frame" button first
 Adobe Premier Elements

—Action bar: tools>freeze frame
— Clickexport

How to Create a Freeze Frame

* Quicktime (windows)
— Export>movie to picture or
—File>print>PDF

« iPad/iPhone

—Home+Power
— Various apps for screen shooting

36



How to Create a Freeze Frame

& - Windows Screen Shot
. — Windows+print screen
(full screen}

— Alt+print screen
(selected window}

» Mac Screen Shot

i - — Command-+shift+3 (full
. — __ “__j screen}
. 7 - — Command-+shift+4
seeBIUsWECEELPQ @ W (selected area}

Essential Graphic
Design Concepts

Presented
by

Ana Henke
Publications Supervisor and Graphic Designer
New Mexico State University
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Essential Graphic Design Concepts

Resolution

» The amount of information or pixels
contained in an image.

* Resolution is measured in DPI (dots per inch) or
PPI (pixels per inch). These are literally the
number of dots or pixels that can be placed side by
side in a line one inch long. The more dots or
pixels, the better the clarity — the higher the
resolution — of the image.

Essential Graphic Design Concepts
Dots Per Inch (DPI)

The image on the
right shows you the
actual DOTS that
are used to print a
photograph on a
printing press.

2/14/14
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Essential Graphic Design Concepts
Resolution: Why is it SO important forprinting?

{ <

high resolution

Essential Graphic Design Concepts

low resolution

Resolution: How do you know when an image has

high resolution?

Tip 1:

Photoshop,

a photo editing
software, allows
you to open

the image file
and look up

the resolution.

It should be

300 dpi or
higher.

Width: [5.533 inches 8]
it
Height: [7.007 inches 8]
Resolution: | 300 pixels/inch 8]
PRl scale Styles
Ml # Consirain Proportions
PO @ Resampie Image: | Bicubic

2/14/14
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Essential Graphic Design Concepts

Resolution: What if you don't have Photoshop?
Tip 2: Image is probably low resolution:

* if the placed or inserted image is SO small you have to
enlarge it.

« if the image’s file size is smaller than S00KB (kilobyte).

Tip 3: Image is probably high resolution:

* if the placed or inserted image fills the page
* if image is at least 1MB (megabyte)

Tip 4: PC users can right-click an image then choose
"properties” to see resolution.

Essential Graphic Design Concepts

Resolution: Where can you find file size?

Plants for Rio Crande Basin BOOK (Inj

Name
W agave americana-2.uif 14/ 2 Adob...FF file
W8 agave americana-3.0f 14107 2™ Adob. . IFF file
@ agave americana-4.tif 14707 ™ Adob.. IFF file
Adob. _IFF file
Adob. _IFF file
Adob... FF file
) 2 Adob. IFF file
agave par 1 14107 Adob.._IFF file
{0 oesvro ryfe. 14107 2 Adob. _IFF file
» Aoolcatices - ailanthus altissima.nf 171 2 Adob.._IFF file
4 MR aloe baubadensis-2.uf 14107 2 Adob. . IFF file
M aloe baubadensis.tif 14107 Adob. _IFF file
B Attemisia  idviana.uf 125/ Adob...IFF file
W Asceplas tuberosa.uf /14 Adob. . IFF file
W Asclepias T a leaves.uf 2/14) Adob. . IFF file
W astriplex ¢ ens fruit.f (4107 Adob.IFF file
W atripiex canescons.tif 14107 2 Adob..IFF file
BB cistus pai.uf /18/06 Adob. . IFF file
B cistus purpureas.uf 12/18/06 Adob.. IFF file
B cistus purpureus.tif 12/18/06 Adob.. IFF file
B8 codatevia seliovara.f 114107 2 Adob._IFF file
B8 Cypsophill  niculata.tif 12/14/06 2 Adob . FF file

- 5t et o

222 items, 190.91 CB avaiable

2/14/14
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Essential Graphic Design Concepts
Understanding Image formats

* Rasterimages (i,
JPEG, GIF, PNG, PICT, BMP):
These types of images are
composed of pixels and are
dependant on resolution for
clarity (photos, line art, etc.)

* Vectorimages rs):
These types are images are not
dependant on resolution and

can be enlarged without
distortion.

Essential Graphic Design Concepts

Vector Image

-

This example shows

you howyou can

modify a vector file

by extending some of
the anchor points.

Vector image with

anchor points

2/14/14
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Essential Graphic Design Concepts

Good sources of image files

 Digital camera images set at the
highest resolution setting.

« Slides or photos that you can scan yourself.
(Tip: Scan at 300 dpi and scale [enlarge] images
to final desired size during scanning stage.)

* Downloadable high resolution images. (Always
remember to look into copyright permission when
using photos produced by a third party.)

Essential Graphic Design Concepts
Scanning tips &

* When scanning line art or text, set
your scanner to black/white, NOT
grayscale. Image will print much
more clearly.

* o

* Scan photos/slides at 300 dpi and line art at 900 dpi.

* Scale (enlarge) your images at this stage.

Ex: If you have to scan a slide, scale (enlarge) it up to 300%.
That will enlarge the image to 3 times its original size at 300dpi
so it will be BOTH clear and larger.

2/14/14
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Essential Graphic Design Concepts

Typlca_l opriteman B | Q2 {2 '
Scanning
Setup '
Output type/ e -
Resolution St
(dpi)
Scale

= =

Downloadable high
resolution images.

Bugwood.org

43
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Essential Graphic Design Concepts

Bad sources of image files for print

* Screen captures
Images on the Web

are usually only 72 dpi.
(Find out about copyright before
using any online image, and

be careful to not use images
with watermarks.)

« Cut or copied and pasted images
I do NOT recommend copying a pasting images from one

software into another! The image quality will degrade every time
this is done and the resolution is usually low.

Essential Graphic Design Concepts

What if the only photo you have is within
a MS Word document?

I do NOT recommended copying/pasting images; however, if the
clarity of the image looks good (by that I mean NO pixels) and
the image is the only thing on the page, you can make a PDF of
the page and insert the PDF into your document as a graphic.
You can also print the image, scan it at 300 dpi and insert into
your document as an image.

The quality won’t be as good as an original, high resolution
image, but it may be adequate.
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Essential Graphic Design Concepts

What if the only photo you have is within a
PDF document?

If you have Photoshop, you can open the PDF,
crop out the image and save the file as TIFF image.
If you don’t have this software, you can print the
page, scan it at 300 dpi and insert into your
document as an image.

The quality won’t be as good as an original, high
resolution image, but it may be adequate.

Essential Graphic Design Concepts

How to convert a PDF into a graphic file using Photoshop.

- e, File > Open > 2 i3
> =3 T filename.PDF. i
E| 2 ] ] Make sure i1

% e —a resolution
Sosce h_;'}']', is 300 dpi. e ¢
e Dot —7
e (3 >

. Selectthe _—

it photo with the
i - 1 Rectangular s e b et s g i
Marquee Tool.

File > Save As >
TIFF format

Image > Crop

45



Essential Graphic Design Concepts

What image formats are best to use for print?

* TIFF format is preferred by the print
industry for photos, etc.
— If your project is going to be printed on a
printing press all images need to converted
to CMYK mode.

« EPS, Al format is preferred for illustrations.

Essential Graphic Design Concepts
Whatis CMYK and whatis RGB?

The CMYK color model stands for Cyan, Magenta, Yellow and blacK. When a
color photo is printed it is literally separated into these four colors and printed one
color at a time. These four colors then combine to give you the full color image.

When a photograph is going to be reproduced on a traditional printing press or on
today’s digital presses or color printers, photos should be converted to CMYK format
prior to reproduction to ensure color accuracy.

The RGB color model stands for Red, Green and Blue. Files in RGB format
are intended for use on electronic systems like TVs, mobile phone displays and
computer monitors.

You’ve probably noticed that the colors of photos on different electronic devices
often look different—that is because each device reads the color breakdowns
differently. You don’t want this type of inconsistency in print.

2/14/14
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Essential Graphic Design Concepts

How do | change a file from RGB to CMYK to prepare
file for printing?

The only way to change a
file from RGB to CMYK
format is to use Photoshop.

@ Photoshop File Edit JLOTLl Laver Select Fiter View Window Help

Adjustments »| GCrayscale

Duplicate... Indexed Color...
Apply Image... ¥ RGB Color
Calculations...

You would go to Image >
Mode > CMYK Color.

Lab Color Ag Lab 2-001030.jpg @ 33.3% (R
i

Image Size... X% SRty

1
Canvas Size... X%C
Pixel Aspect Ratio » | ¥ B Bits/Channel
Rotate Canvas > 16 Bits/Channel

Trim...

Also, remember to to save
the file in TIFF format.

If you don’t have this
software, pre-press
staff at your print shop
will need to make the
change for you.

|
[
Copyright and Fair Use

Copyright can be a confusing subject, but you can stay on the right
side of the law by following a couple of easy rules.

Public Domain
Works in the public domain are not protected by copyright and may be freely reproduced.

The two biggest categories are US Government works and works produced before
1923.

Even though they are not copyrighted, you should still provide a citation when
reproducing public domain works.

Copyrighted Works

If a work is copyrighted, you may be able to reproduce it if your use can be considered
“fair use.” Fair use can be tricky to determine, though. To be on the safe side, always
request permission (in writing) from the work’s owner or copyright holder to reproduce
any copyrighted work. If you’re unsure about whether a work is copyrighted, just assume
that it is.
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Questions and Answers

Thank you for participating in today’s webinar!
We hope you’ve found it useful.

2/14/14
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